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Symbols and Numerics
### (pound signs) in an Excel cell, 463
& (ampersand), 561
@ (at symbol), 561
< (left bracket), 561
< (less than) operator, 597, 604
<= (less than or equal to) operator, 597
<> (not equal to) operator, 597
= (equals sign), entering a formula, 494,

505
= (equal to) operator, 597
> (greater than) operator, 597, 604
> (right bracket), 561
>= (greater than or equal to) operator,

597
( ) (parentheses) in formulas, 493
/ (slash), starting AutoCorrect entries, 68
3D

chart, 127
diagrams, 148
reference, 499

A
.accdb extension, 31, 546
Access

color scheme for, 657
database addresses, 261
description of, 10
file formats, 546
files in the latest version, 546
Spelling button on the Home tab, 70
status bar, 656

Account Settings dialog box, 299
Accounting Number Format, 470
accounts

handling e-mail, 333
sending messages, 326–327

action buttons in user-run presentations,
448–450

active cell
describing, 459, 460, 461
designating, 462
scrolling to, 477
selecting column or row of, 483

activities
canceling, 355
categorizing, 356
rescheduling, 356
scheduling, 353–355

Add Assistant command, 140
Add Bullet button, 144
Add Clips to Organizer dialog box,

693, 694
Add Contact Photo button, 307
Add Custom Dictionary dialog box, 74
Add New Category dialog box, 294
Add Shape commands, 136–137, 138,

139–140
address block, 263
address book, 290
Address Cards view, 310
address labels, printing, 259–260
addresses

entering in the Contact form, 307
importing into Outlook, 300
mapping, 309
printing on envelopes, 257–258

administrator for a Web site, 709
Adobe Acrobat Reader, 663
Advanced E-Mail Options dialog box, 332
Advanced Filter/Sort Command, 594, 597
Advanced Find dialog box in Outlook,

297
Align button, 167–168, 169
Align commands, 167–168, 417
aligning objects, 167–168
Alignment group button, 510
All Accounts group, 333
All Caps text, 44
All Day Event check box, 355

Index
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All Fields window in Outlook, 308
All Slides dialog box, 442
Allow Zero Length property, 567
alphabetizing lists, 267
Alt key, pressing, 21
Alt+Ctrl+D, 280
Alt+F2, 291
Alt+F4, 29
Alt+F8, 722
Alt+F9, 426
Alt+Shift+L, 269
Alt+Shift+M, 266
Alt+Shift+minus sign, 269
Alt+Shift+O, 274
Alt+Shift+plus sign, 269
Alt+Shift+X, 274
AM time designation, 467
animation schemes, 428–429, 430
animations, 427, 441
annotations on charts, 125
antonyms, 81
Append Only property, 568
Application Data folder, 226
Apply Filter button, 594
Apply Styles task pane, 219
Appointment Recurrence dialog box,

354–355
Appointment window, 291, 353, 354
appointments

reminders for, 363
scheduling, 290, 351, 353

archiving, items in Outlook, 301–303
area chart, 112
arguments in functions, 505
arithmetic operators, 492
Arrange All button, 64
arrival notices for e-mail, 332
arrowheads on lines and connectors,

155–156
arrows

changing the appearance of, 154–155
on connectors, 157
drawing, 152–153
handling, 153–157

art, manipulating, 162–173
artwork for borders, 243
ascending sort, 95, 572, 591–592
ASF (Advanced Systems Format), 434
aspect ratio, 166, 683
assistant shapes, 140
Attach File button, 325
Attach Template dialog box, 225
attached files

opening received, 337
previewing, 337–342
receiving, 335–336
saving received, 336
sending, 663–664

attaching, files to e-mail messages, 325
Attachment data type, 561
audience, handouts for, 445–446
Auto Brightness button, 682
Auto Recovery files, 24–25
AutoArchive dialog box, 301–303
“autoarchiving”, 301
AutoCorrect button

in Picture Manager, 681
in the Spelling and Grammar dialog

box, 66
AutoCorrect command, 67–68
AutoCorrect dialog box, 65
AutoCorrect list, 72
AutoCorrect Options button, 

210, 211, 659
AutoCorrect tab, 66, 67, 68
AutoFill command, 467–469
AutoFill handle, 469, 500
AutoFit button, 94, 234
AutoFit Contents button, 94
AutoFit options, 416
AutoFit Options button, 414, 415
AutoFit Text option, 634
AutoFit Window button, 94
“AutoFitting”

columns, 514
dispensing with in PowerPoint, 417
text one frame at a time, 414–415

autoflow mechanism, 632
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AutoFormat As You Type tab, 211, 416
automatic e-mail collections, 331
automatic hyphenation, 215
automatic links, 732
automatic lists, 211
Automatically Update Document Styles

check box, 225
AutoNumber data type, 560, 562
AutoPreview button, 335
AutoSave files, 24
AutoSum button, 506
Available Editing Languages box, 82
AVERAGE function, 504
Avg function, 606
AVI (Audio Visual Interleaved) video

format, 434
axes labels, 117
axis labels, 119

B
background(s)

changing for slides, 403–404
for pages in Publisher, 645–646

background colors
applying to cells, 518
for the Calendar window, 357
for frames, 645

background styles
for handout pages, 446
for slides, 393–395

Background Styles button, 397, 400, 402
background style variation for themes,

396
Background task pane, 645–646
balloons, 252, 254
banded columns or rows in tables, 98
bar chart, 112
bar tabs, 213
baseline guides, 627, 628
batch program files (.bat), 336
Between operator, 597, 604
bibliography, 283–286
bitmap graphics, 670

black screen, during a presentation, 444
blank database file, 543
Blank Document icon, 181, 182
Blank Presentation icon, 373
Blank Template icon, 225
blank workbook, 458
blind copies, 319–321
block of cells, selecting in worksheets,

483
block of text, selecting, 36
Blocked Senders list, 345
blog, 666, 668
blog account, 667–668
Blogger, 667
blogging from inside Word, 666–668
blogging services, 666, 667–668
boilerplate text in PowerPoint templates,

374
bold font style, 43
boldface, 39
bookmarks

for an index page range, 276
in Word, 190–191

borders
decorating pages with, 242–243
decorating worksheets, 514
designing for tables, 98–100
on different sides of the page, 243
on frames in Publisher, 644–645
of tables, 88
on worksheet cells, 516–518

Borders button
drop-down list on, 99
On the Home tab, 517
on the (Table Tools) Design tab, 104

Borders commands, different effects of,
99–100

Break Forward Link button, 634
Break Link button, 242
breaking

columns, 240
links, 733

Breaks button on the Page Layout tab,
196, 198, 240, 521
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brightness
for clip-art images, 688
in Photo Album, 389
in Picture Manager, 682

Brightness commands, 674–675
Bring Forward command, 170
Bring in Front of Text command, 170
Bring to Front button, 106
Bring to Front command, 170
Browse by icons, 188
Browse the Web button, 57
browser, 666
browser window, Research task pane in,

79–80
browsing around a document, 188–189
bubble chart, 112
Building Blocks gallery, 208
bullet(s)

changing the size of, 420
customizing, 419
describing, 210, 418

bullet characters
changing in lists, 419
choosing a different, 211

bullet points, as distracting, 376, 377
bulleted items, removing from diagrams,

144
bulleted lists

characters for, 419
creating in PowerPoint, 418
described, 210
entering, 144
turning into digrams, 143

Bulleted tab, 419
business information in Publisher, 625
buttons

with an arrow, 17
on the Quick Access toolbar, 654–655
on Ribbon tabs, 14
on tabs, 17
without an arrow, 17

Byte field size, 564

C
calculation query, 607–608
Calendar

introducing, 349–350
reconfiguring, 352

Calendar window, 356, 357
callout shape, 125
cancelling, activities, 355
cap of a line. See line caps
capitalization

handling, 46–48
preventing errors, 66
in Word documents compared to

PowerPoint, 382
Caps Lock, accidental usage of, 66
Caption property for fields, 565
captions

for cross-references, 278
for photo album pictures, 388, 389

Card Style for contact information, 311
Cascade Update Related Fields option,

577–578
case

handling, 46–48
matching in searches, 51

cataloging, media files, 694
categories

on a chart, 108, 109
in Outlook, 294–296

categorizing, received e-mail messages,
338

category axis. See horizontal axis
CDs

copying large files onto, 649
packaging presentations on, 451–452

cell(s)
borders on worksheet, 516–518
clicking in Excel, 494–495
copying and moving, 484
in database tables, 539, 540
deleting, 484
in different worksheets, 499
in formulas, 489–491
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merging, 92
reorienting in worksheets, 510
selecting, 91, 483
splitting, 92
in tables, 87
in worksheets, 459, 460

cell addresses in worksheets, 459, 461
cell ranges

entering in Excel, 495–496
moving to named, 498
naming in Excel, 496–498

cell references
across worksheets, 499
entering in formulas, 494–495
recording as relative in Excel, 719
tracing in Excel, 502–503

Cell Size group button, 93
Cell Styles button on the Home tab, 516
cell styles, creating, 514–516
Cell Styles gallery, 514–515
cell tracers, 503
center tab, 213
Change Case button, 47
Change Chart Type button, 114
Change Page Size button, 624
Change Shape button, 147, 159, 160
Change Styles button, 219
Change Template button, 623
chapter numbers, including page

numbers, 204–205
Character Shading text effect, 45
character styles, 218
chart(s)

annotating, 125
appearance of, 114–122
creating, 109–111
creating from templates, 123
decorating with pictures, 123–125
in Excel, 460, 461
inserting in presentations, 373, 425
positioning, 113
saving as templates, 122–123
troubleshooting, 127–128

types of, 111–112
in Word documents, 231

chart elements
changing, 120–122
formatting, 121–122
locating and labeling, 116–117

chart floor of a 3D chart, 122
Chart Layouts gallery, 126
chart styles, 115
chart title, 117
(Chart Tools) Format tab, 111, 121
Chart Tools tabs, 111, 114
chart types

changing, 114
selecting, 110

Check Addresses dialog box, 307
Check Grammar check box, 76
Check Names button, 319
Check Spelling As You Type check box, 71
Choose a SmartArt Graphic dialog box,

130, 131, 132
citations

editing in a bibliography, 285–286
inserting in a bibliography, 284–285
removing, 286

Classic style set, 219
Clear All command for styles, 219
Clear All Sorts button, 592
Clear button

on the Data tab, 529
on the Home tab, 470, 484

Clear Find Format option in Excel, 52
Clear Formatting button, 39, 43
clip art

describing, 685–686
getting from Microsoft, 692

Clip Art task pane, 686–687
Clip Organizer

adding media files to, 692–694
creating a My Collections subfolder,

695–696
description of, 10, 685, 687
handling media files, 688–696
parts of, 688–689
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clip-art images
adjusting the appearance of, 687–688
inserting, 426, 686–687
placing in a slide background, 400–401
in Word documents, 232

Clipboard, 36
Clipboard task pane, 36–38
Clips Online button, 692
Close button

in the Reminder message box, 363
on the Word screen, 180
X in the corner of the window, 29

closing files, 29
CMYK. See process colors
Code window, reading macros in, 723
Collection List, 691
Collection List task pane, 688, 689
color(s)

applying to objects, 174
balancing in Picture Manager, 682
for borders, 243
for bullets, 420
for a chart’s plot area, 122
for columns, rows, or tables, 100
decorating worksheets, 514, 518
for a diagram shape, 147
for drawing on slides, 443
filling an object with, 174–175
for gridlines in a chart, 120
for highlighting, 249
making transparent, 175
for shape outlines, 176
for slide backgrounds, 394, 397
for text, 45–46
for text in presentations, 411–412
for themes, 239, 396
for underlining, 45

color backgrounds on frames in
Publisher, 644–645

Color Categories dialog box, 294, 295
color schemes

changing, 657
choosing, 623

color systems, preferred by printers,
648–649

column(s)
aligning text in, 91
calling attention to tables, 98
changing the size of, 93–94, 512–514
in a datasheet, 582
freezing and splitting in Excel, 478–481
hiding in datasheets, 584
hiding in Excel, 481
inserting and deleting in tables, 96
inserting and deleting in worksheets,

511–512
moving in tables, 96–97
number of, 240
rearranging in datasheets, 585
resizing in datasheets, 585
selecting, 91
selecting for an index, 277
selecting in worksheets, 483
sorting on Excel, 526–527
width of, 240
in worksheets, 459, 460, 461

column chart, 112
column headings, repeating on each

page, 524
column input cell, 533
Column Input Cell text box, 534
column labels, 525
column letters, 523
Column Width dialog box, 514
Columnar layout, 587
Columns dialog box, 239–240
combo box for a form, 193
Comma Style number format, 470
commands

keyboard shortcuts to, 658–659
organized into groups on tabs, 16–17
same throughout Office, 10

commas in lists, 233
comments

deleting, 251, 482
describing range names, 497
documenting worksheets, 481–483
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editing, 252, 482
entering in Excel, 482
entering on documents, 250–251
finding, 482
in macros, 723
moving from one to another, 251
by a particular reviewer, 251
printing in worksheets, 483
reading in Excel, 482
temporarily removing, 251

common filters, 594–595
Communicate group, 309
compacting the Outlook data file, 303
company logo. See logo
Compare button, 255
Compare Documents dialog box, 255–256
comparison operators, 596–597, 603–604
compatibility mode, 24
compatibility with earlier file

versions, 23
component parts, 664–665
compound files, 727
compressing

files, 453
graphics in Picture Manager, 684
graphics to save disk space, 677–678

compression, 671–672
computer viruses

in e-mail, 336
in macros, 716

computerized form, 192–194
conditional formats, 471–472
Confirm Password dialog box, 32
connectors

adjusting, 157
arrowheads on, 155–156
changing the appearance of, 154–155
handling, 153–157
using to connect shapes, 156–157

consistency
of charts, 115
of diagrams, 146
in PowerPoint design, 404

constants, 491

Contact form, 306–308
contacts

changing information, 308
entering, 306–308
finding, 308–310
in Outlook, 305
printing information about, 311–313

Contacts folder
in Business Cards view, 292–293
entering new contacts, 306–308
filing contacts in, 307
finding contacts in, 308–310
getting e-mail addresses from, 318
maintaining, 305–313
printing, 310–313
typing a person’s name from, 318

Contacts window, adding reminders in,
363

containers, notes appearing in, 701
Content Control Properties dialog box,

193–194
content frames, 407
content placeholder frames, 378
context-sensitive group buttons, 17
context-sensitive tabs, 15–16
continuation slugs, 635
Continuous section break option, 196
contrast

for clip-art images, 688
in Photo Album, 389
in Picture Manager, 682

Contrast commands, 674–675
Convert Notes dialog box, 283
Convert to SmartArt button, 143
copies of e-mail messages, 319–321
Copy and Paste commands, 728
Copy to Collection command, 695
copying

formulas from cell to cell, 499–501
notes into Office programs, 707
and pasting in Excel, 484
styles, 227–229
text, 36

copyright law, regarding graphics, 673
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COUNT function in Excel, 504
Count in Access, 606
Create Link button, 242
Create New Building Block dialog box,

208
Create New Business Information dialog

box in Publisher, 625
Create New Folder dialog box, 343–344
Create New Style from Formatting dialog

box, 222–224
Create Rule dialog box, 341, 342
Create Source dialog box, 284
Create tab in Access, 554
Create Table dialog box, 637
Create Text Box Link button, 634
criteria

entering for a query, 603–605
filtering with, 528

cropping
graphics, 676–677, 683
an image, 674

cross references in an index, 275–276
cross-references

creating, 279–280
putting in documents, 278–280
updating, 280

Ctrl+’, 491
Ctrl+[, 42
Ctrl+], 42
Ctrl+1, 209
Ctrl+2, 209
Ctrl+5, 209
Ctrl+6, 291
Ctrl+A, 36, 280, 481, 483, 631, 634
Ctrl+Alt+1, 219
Ctrl+Alt+2, 219
Ctrl+Alt+3, 219
Ctrl+Alt+A, 296
Ctrl+Alt+S, 331, 333
Ctrl+Alt+W, 296
Ctrl+B, 43
Ctrl+Backspace, 477
Ctrl+Break, 722
Ctrl+C, 36, 38

Ctrl+clicking objects, 164
Ctrl+D, 298, 362
Ctrl+E, 296
Ctrl+Enter, 198, 483
Ctrl+F, 49, 588, 589, 705
Ctrl+F3, 524
Ctrl+G, 189, 351, 626
Ctrl+H, 590
Ctrl+Home, 187
Ctrl+hyphen, 215
Ctrl+I, 43
Ctrl+K, 56–57, 58, 59
Ctrl+M, 200, 212, 381, 646
Ctrl+N, 182, 225, 306, 316, 353, 360,

458, 621
Ctrl+P, 311, 662
Ctrl+S, 317, 442, 722
Ctrl+Shift+C, 306
Ctrl+Shift+E, 253, 343, 707
Ctrl+Shift+Enter, 240
Ctrl+Shift+F5, 190, 276
Ctrl+Shift+F9, 271
Ctrl+Shift+L, 219, 323
Ctrl+Shift+M, 200, 212
Ctrl+Shift+N, 219, 639, 701
Ctrl+Shift+Spacebar, 483
Ctrl+Shift+V, 343
Ctrl+Shift+W, 628
Ctrl+Spacebar, 483
Ctrl+U, 43
Ctrl+V, 36
Ctrl+X, 36
Ctrl+Y, 62
Currency data type, 560
current date, entering in Excel, 466
current time, entering in Excel, 467
cursor. See also pointer

moving in a table, 90
Curved Connector, 157
Custom Animation button, 430
Custom dialog box, 340
custom dictionary, 73–75
custom groups in Access, 548
Custom Lists dialog box, 468
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custom mark for a footnote or an
endnote, 282

Custom number filters, 595
Custom text filters, 594–595
Custom Views button, 480
Custom.dic dictionary, 73, 75
Customize category of the Options

dialog box, 654
Customize Keyboard dialog box, 658
customized animations, 428
customized views in Excel, 480
Cut button, 36
cutting and pasting slides, 386
cutting in Excel, 484
cycle diagrams, 130, 136

D
dash for shape outlines, 176
dash status of a line, 154, 155
dashed line, selecting in Publisher, 643
dashes, compared to hyphens, 216
data

compacting Outlook, 303
into database tables, 581–582
in Datasheet view, 582–585
deleting, copying, and moving in Excel,

484
deleting from an Excel cell, 113
displaying in fields, 561
embedding from other programs,

733–736
into an Excel cell, 113
finding and replacing, 589–590
in forms, 194
into forms, 586–587
linking to, 730–733
presenting in a report, 611–616
separating into different database

tables, 548, 549
in worksheets, 462–463, 475–476
in the Zoom box, 584

data labels, 109, 116, 117

data markers
in a 3D chart, 127
changing the color of, 124
in a chart, 108, 109

data point on a chart, 109
data series on a chart, 108, 109
Data tab

Data Validation button, 474
What-If Analysis button, 530, 532, 533

data table(s)
appearing along with charts, 108
displaying with charts, 126
performing what-if analyses with,

530–534
Data Table button, 126
Data Table dialog box, 533–534
data types

choosing, 558–559
selecting, 560–561, 660

data validation rules in Excel, 472–474
database(s), 539, 540

designing, 546–552
as initimidating, 537
as intimidating, 537
introducing, 537–538
querying, 541–542
terminology of, 539, 540

database files, 542–544
database tables, 538–539, 540

choosing fields for, 548, 550
choosing which to query, 600
creating, 553–557
entering and altering fields, 558–563
entering data into, 581–582
filtering, 593–594
importing from another database,

556–557
isolating specified records in, 593
mapping relationships between,

551–552
number needed, 548, 549
opening and viewing, 557–558
primary key fields for, 550–551
relationships between, 573–579
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database tables (continued)

in the Relationships window, 576
restricting by subject, 548, 549
separating information into different,

548–550
sorting records in, 591–592

database tools tab, 575–576
data-entry controls, 192, 193–194
data-entry drop-down lists, 563, 568–570
datasheet

changing the appearance of, 585
keyboard shortcuts for, 583

Datasheet view, 557–558
in Access, 557–558
entering data in, 581, 582–585

date(s)
in charts, 127
in Excel, 469–471
on handout pages, 446

date and time
inserting in headers or footers, 207
placing on slides, 422

date criteria in Access queries, 603,
604–605

date formulas in Excel, 464–466
Date( ) function, 605
Date Navigator, 350, 351
date picker for a form, 193
date values

data validation, 473
entering into worksheets, 464–466, 467

Date/Time data type, 560
days

capitalizing names of, 66
clicking in the Date Navigator, 351

Decimal field size, 564
decimal numbers, entering into Excel,

464
Decimal Places property for fields, 565
decimal tab, 213
Decrease Decimal number format, 470
Decrease Font Size button, 411, 415
Decrease Indent button, 212

default account for sending messages,
326

default browser, 666
default documents, 182
default e-mail program, 317
Default File Location text box, 22
default format

for e-mail messages, 330
for saving files, 23

default line style, 155
default style for an object, 176
Default Value property, 565–566
Define Name button, 497
Define New Bullet dialog box, 211
Define New Number Format dialog box,

211
Delay Delivery button, 327
Delete button

in Outlook, 297
on the (Table tools) Layout tab, 96

delete query, 608–609
Delete Repeated Word option, 70
Deleted Items folder, 298
deleted material, 254
deleting

endnotes or footnotes, 283
fields in Access, 563–568
files in the Open dialog box, 27
Outlook items, 298
rows or columns in worksheets, 511
slides, 386
styles, 227
text, 38

delivery recipient, 328
Demote to Body Text button, 270
demoting in hierarchy diagrams, 141
dependents in Excel, 503
depth of a TOC, 271
descending sort, 95

indexes in Access, 572
records in, 591–592
top value queries in, 606

descriptions, entering for fields, 559
descriptive names for fields, 548, 550
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design
options in Publisher, 624
for a report, 612, 614
templates, 621

Design Checker, 647–648
Design Gallery in Publisher, 635, 647
Design grid

listing field names, 601
in the Query Design window, 599, 600
sort row, 601–602

Design tab
Background Styles button, 397, 400, 402
changing a chart’s appearance, 114

Design view
in Access, 557–558
creating a query in, 599
opening objects in, 545

Design window in Access, 554
desktop alert, 332
desktop publishing. See also Publisher

with Word, 231–247
Desktop shortcut icons. See shortcut

icons
destination formatting, matching, 37
Details button

on a Contact form, 307
in the Task window, 361

Developer tab
displaying, 715–716
Document Template button, 225
Macro Security button, 716
Record Macro button, 719

diagonal lines, drawing on tables,
104–105

diagram shapes
appearance, 146–148
bulleted lists on, 144
exchanging one for another, 146–147
fonts on, 148
laying out, 134–141
restyling, 147
selecting, 134
size of, 146
text on, 141–144

diagrams, 129
adding shapes to, 135–141
changing direction of, 144–145
changing size and position of, 133
choosing a look for, 145–146
consistency of, 146
creating, 132
creating from scratch, 149
creating from SmartArt graphics,

129–131
creating initial, 131–133
inserting in presentations, 373, 425
removing shapes from, 135
swapping one for another, 133
types of, 130
in Word documents, 232

dialog boxes
all options recorded for, 723
visiting while recording macros, 721

dialog box launchers. See group buttons
diamond, dragging to change a shape’s

symmetry, 159, 160
diaries, online, 666
.dic (dictionary) file, 73
dictionary

adding misspellings, 72
creating a new, 74
employing other, 73–74
entering and editing words in, 75
in Office, 69
shared by Office programs, 72

dictionary attack, 346, 348
digital signatures, certifying macros, 717
Direct Relationships button, 576
Dismiss button, 363
Display for Review drop down list, 254
Distinguish Style Source check box, 197
Distribute Columns button, 94
Distribute commands, 168
Distribute Rows button, 93
distributing, titles in a text frame or text

box, 418
distribution lists, 322–324
.doc extension, 31
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.docm extension, 31, 718
document(s)

attaching templates to, 225
browsing around, 188–189
commenting on, 250–252
comparing parts of, 197
constructing default, 182
copying styles into, 227–228
creating new, 181–182
creating templates from, 226
definition of, 181
editing with many sections, 197
embedding in an Excel worksheet, 729
handling two-sided, 200
highlighting parts of, 249–250
hyphenating, 214–216
indexing, 273–278
inserting a whole file into, 191
landscape, 246–247
marking index entries in, 275–276
moving around quickly in, 187–191
newspaper-style columns in, 239–240
numbering the pages of, 202–205
portrait, 246
putting cross-references in, 278–280
putting footnotes and endnotes in,

280–283
recycling, 182
with revision marks, 254
revisions to, 256–257
selecting, 187
slide titles from headings, 381–382
themes for, 238–239
tracking changes to, 252
tracking revisions to, 252–257
transferring notes to Word, 707
viewing, 183–185, 269

document map in Word, 189
document properties

entering, 29–30
erasing, 30

Document Recovery task pane, 25
document sections. See sections
Document Template button, 225

.docx extension, 31
domain, 345
dots per inch (dpi), 671
dotted lines. See dash status of a line
Double field size, 564
double strikethrough, 43
double-headed arrow pointer, 93
doughnut chart, 112
downloading files, 713
dpi (dots per inch), 671
Draft view

describing, 184, 185
determining where sections end, 197
entering footnotes or endnotes, 280
inserting hard page breaks, 198
reading comments in, 250

Drafts folder, 317, 327
dragging

objects, 166
the pointer, 19

dragging and dropping
in Excel, 484
slides, 386
text, 36

Draw Table button, 92, 105
Draw Text Box, 241
Draw Vertical Text Box, 241
drawing

action buttons, 449–450
arrows, 152–153
lines, 152–153
with a pen or highlighter, 701, 702–703
ruler guides, 628–630
shapes, 152–153
on slides, 442
on tables, 105–106

drawing canvas, 237 238
drawing commands, 151
drawing guides, 426
(Drawing Tools) Format tab, 153
drop caps, 244, 643–644
drop-down list, 193, 568–570
due date for a task, 360
duplicate information, finding, 548, 549
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duplicate slides, 381
dynaset, 540

E
Edit Business Information Set dialog box,

625
Edit Citation dialog box, 285–286
Edit Comment button, 482
edit, going to the most recent, 188
Edit in 2-D button, 148
Edit Photo Album dialog box, 390
Edit Pictures task pane, 681
Edit Recipient List button, 263
Edit Relationships dialog box, 577–578
Edit Shape button, 159, 160
Edit Source dialog box, 285
Edit Word List button, 75
Edit Wrap Points, 236
editing

documents with many sections, 197
embedded data, 736
endnotes or footnotes, 283
footers, 206
headers, 206
indexes, 278
macros, 722–723
pictures in Picture Manager, 681–684

Elbow Connector, 157
Elegant style set, 219
eLibrary, 78
em dash, 216
e-mail

hyperlinks, 59
importing into Outlook, 300
sending notes by, 707

e-mail accounts, Web-based, 347
e-mail addresses

collecting on the Internet, 346
creating secondary, 347
entering for contacts, 307
entering the recipient’s, 316
junk e-mailers obtaining, 346
posting on the Internet, 347

purchasing, 346
safeguarding, 346–348

E-Mail button on the Standard toolbar,
707

e-mail messages
accounts for sending, 326–327
addressing, 318–319
addressing to distribution lists, 323
Autopreviewing, 335
categorizing, 295, 338
collecting received, 331–332
contact information from, 308
creating folders for, 343
default format for, 330
deleting, 337
earmarking on arrival, 341–342
entering, 317
flagging, 338–339
folders for, 342–344
formats for, 329–330
marking as unread, 335
moving to different folders, 

337–338, 343
notification of the arrival of, 332
pictures in, 325–326
postponing sending, 327
prioritizing, 324
reading, 332–335
receiving, 331–335
reminders to take care of, 339–341
replying to, 318–319, 321–322
scheduling appointments, 356
scheduling reminders, 363
searching in different folders, 296
sending, 316–317
sending copies and blind copies of,

319–321
sending files in, 325, 663–664
sending from other Office programs,

319
signatures for, 330
techniques for organizing, 337–342

E-Mail Options dialog box, 317, 321
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e-mail program
default, 318
Outlook as, 290

E-Mail Properties dialog box, 321
embedded files, 431, 435, 451
embedding

about, 728
data already created, 735
entire files, 736
foreign data, 733–736
pitfalls of, 730
uses for, 729

Emboss text effect, 45
Empty the Deleted Items folder Upon

Exiting option, 298
en dash, 216
Enabled Editing Languages box, 82
Encarta dictionaries, 78
Encarta Encyclopedia, 78
Enclose Characters text effect, 45
endnotes, 280–283
Engrave text effect, 45
entry, posting to a blog, 668
envelopes

creating addressed, 262
finishing touches on, 265
printing, 264
printing addresses on, 257–258

Envelopes and Labels dialog box,
259–260

equal to (=) operator, 597
Equalize Character Height, 43
equals sign (=), entering a formula, 494,

505
Eraser button, 89
Eraser in PowerPoint, 444
error alert, 472, 473
Error button, 502
error checker in Excel, 502
error messages in Excel cells, 501
errors, detecting and correcting in

formulas, 501–503
Esc key, 187

Eudora, 300
Even Page section break option, 196
events

scheduling, 351, 355
scheduling reminders for, 363, 364

Excel
addresses in worksheets, 261
color scheme for, 657
constructing worksheets in Word or

PowerPoint, 89
description of, 10
getting acquainted with, 459–461
introduction to, 457–474
positioning charts in, 113
searching for formats in, 51–52
selecting the chart type, 110
selecting worksheet data, 110
status bar, 656

exclusion, filtering by, 528, 593
executable program files (.exe), 336
Expand Navigation Bar button, 703
Expand Query Builder, 296, 297
Expression Builder dialog box, 603
expressions, building, 566
External Data tab in Access, 556
Eyeballing objects, 165

F
F2, 475
F4, 62, 512
F5, 189
F7, 70–72, 76, 317
F8, 187
F9, 272, 280, 331, 631
F11, 545, 701
Factiva Works, 78
Fancy style set, 219
field(s)

choosing which to query, 600–601
data, 539
data types for, 560–561
in database tables, 539
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for database tables, 548, 550
in database tables, 558–559, 562–563
describing, 538
display options, 561
freezing, 584
indexing, 571–573
in query results, 602–603
for reports, 612
sorting on more than one, 592

field columns on the Query grid, 602
field properties

establishing, 563
settings for, 564–568

Field Templates pane, 559
file(s)

attaching to tasks, 361
backing up Outlook, 298–300
bundling with presentations, 451
closing, 29
compressing, 453
converting, 24
decorating with clip art, 685–696
deleting and renaming, 27
deleting from SharePoint Services, 714
displaying side by side, 64
distributing in PDF format, 662–663
downloading, 713
embedding entire, 736
finding Outlook, 298–300
inserting graphics in, 672–674
inserting into documents, 191
linking to over a network, 730
locating saved, 21–22
locking with passwords, 31–33
opening and closing, 26–29
opening with a password, 32–33
password-protecting, 31–32
received as e-mail attachments,

335–337
removing passwords from, 33
saving for use in earlier versions of

Office, 22–23
saving in Office, 21–25

sending in e-mail messages,
325, 663–664

in SharePoint Services, 711–714
speed techniques for opening, 28
turning into Web pages, 665–666
uploading, 712
viewing, 64
viewing and editing, 713–714
in XML format, 30

file attachments from other Office
programs, 329

file extensions
ending in the letter m, 718
in Office 2007, 30–31

file formats
in Access, 546
for graphics and photographs, 669–672

File Name text box, 27
fill, changing for a diagram shape, 147
fill color, removing for overlapping

frames, 638–639
Film Strip view, 679, 680
Filter button in Excel, 527, 528
filtering, 539, 540, 593

by form, 593–594, 596–597
lists in Excel, 527–529
by selection, 593, 595–596

filters
applying to reports, 613
clearing, 594
compared to querying, 598

financial analyses, 529–530
Find & Select button, 477
Find a Contact text box, 310
Find and Replace (or Find) dialog box,

49, 50, 189, 588, 589
Find button in OneNote, 705
Find command

in Access, 588
Ctrl+F, 280
in Excel, 477
locating a name or text passage, 49
in Outlook, 296–297
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Find Format dialog box, 52
Find operation in Word, 50
Find Whole Words Only box, 51
find-and-replace operation, 55–56
fine-tuning video presentations, 435–436
Finish and Merge button, 266
First Column check box, 98
First function in Access, 607
first-line indent marker, 201
Fixed Column Width, 94
flagging

data, 471
e-mail messages, 338–339
notes, 704–705

Flip commands, 171, 683
flow chart type diagram, 131
folder items, finding in Outlook, 296–297
Folder List button, 291
folders

arranging items by category, 295–296
cataloging media files in, 694
cleaning out Outlook, 301–304
deleting items from Outlook, 298
displaying hidden, 226
for e-mail, 342–344
moving e-mail messages, 343
navigating in Outlook, 290
for storing e-mail, 343
viewing items in, 292–293

font(s)
in the Calendar window, 357
in datasheets, 585
described, 38
on diagram shapes, 148
embedding, 649
examining, 41
finding similar, 41
installing and removing, 40–41
on a master slide, 410
removing, 41
for text, 39–40, 410
for themes, 239, 396

Font Color button, 46, 411
Font dialog box

changing fonts, 40
changing font size, 42
in PowerPoint, 411
selecting a Font Style option, 43, 44

font scheme in Publisher, 623
Font Size drop-down list, 42
font sizes

in the Calendar window, 357
changing, 42
decreasing in text frames, 415
on diagram shapes, 148
shrinking in tables, 234
for text in presentations, 411

font styles, 39, 42–43
footers

on all slides, 422
changing from section to section, 207
creating, editing and removing, 206
creating nonstandard in slides, 422–423
defined, 205
fine-tuning, 207–208
in handouts, 446
including logo in, 208
for odd and even pages, 207
page numbers in, 204
putting on pages, 205–208
removing from a single slide, 423
removing from reports, 614
removing from the first page, 207
on the Slide Master, 421
on slides, 420, 421
on worksheets, 523

Footnote and Endnote dialog box,
281, 282–283

footnotes, 280–283
forecasting, 529–530
foreign characters, 48–49
foreign data, embedding, 733–736
foreign field, 539, 540
foreign key, 551
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foreign languages
text written in, 82–83
translating, 83–85

form(s), 539, 540
creating, 586–587
deleting records from, 586
describing, 192
entering data in, 194, 582, 586–587
entering data into databases, 539
entering information in, 192–194
filtering by, 596–597

form letters
creating, 262
finishing touches for, 264
printing, 266

Form Wizard, 586–587
format(s)

for e-mail messages, 329–330
finding, 49–55
searching for, 51–52
stripping data in Excel, 470
for TOCs, 271

Format Axis dialog box, 118
Format button, 52
Format Cells dialog box, 512

Alignment tab, 510, 511
Border tab, 517, 518
describing a new style, 516
Number tab, 465, 470

Format dialog box, 121, 165, 166
Format Painter, 39
Format property for fields, 564
Format Publication task pane, 622, 623
format symbols, viewing hidden, 186
Format tab

changing a chart’s appearance, 114
of the Page Setup dialog box, 313
Shape fill button, 174–175

formatting
commands, 515
embedded and linked objects, 730
marks, 197

formula(s)
copying from cell to cell, 499–501
detecting and correcting errors in,

501–503
displaying in worksheet cells, 491
entering, 494
entering dates in, 466
entering functions in, 505–508
in Excel, 489–493
operators in, 492–493
referring to cells in, 489–491
referring to formula results, 491–492
speed techniques for entering, 494–499

Formula bar
dates displayed on, 466, 467
in Excel, 460, 461
formulas in, 490
listing cell addresses, 462
typing in, 462

Formula dialog box, 100–101
Formula tab

Error Checking button, 502
Name Manager button, 498
Show Formulas button, 501
Trace Dependents button, 503

Formulas tab, 497, 503
forward link for text boxes, 242
forwarding

e-mail messages, 321
notes, 364

frame shape for pictures in Photo
Album, 389

frame tool buttons, 636–637
frames

adding to the Slide Master, 407
borders and color backgrounds on,

644–645
changing size of, 407
horizontal rules on, 642–643
inserting in Publisher, 636–638
lining up in Publisher, 627
moving, 407
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frames (continued)

order of, 639
overlapping, 638–639
positioning, 638
positioning text in, 417–418
in Publisher, 620–621
removing from Slide Master, 407
size and position of, 637–638
sizing, 638
wrapping text around, 635–636

Freeze Columns, 584
Freeze Panes command, 479
freezing columns and rows in Excel,

478, 479
Full Name button on a Contact form, 306
Full Screen Reading view, 183, 184
Function Arguments dialog box, 507, 508
functions

in Access, 606–607
arguments in, 505
entering in formulas, 505–508
in Excel, 504–508
lists of common, 504

G
Galleries, 17–18
General Options dialog box, 31, 32
generic graphics, 636
Gettysburg PowerPoint Presentation, 378
GIF files, 672
Go menu in Outlook, 290, 291
Go To command

in Excel, 477
in Word, 189

Go To Date dialog box, 351
Go To dialog box, 477
Go to Page dialog box, 626
Goal Seek command, 529–530
gradient, 174–175
gradient background for slides, 398–399
grammar checker, 77
Grammar dialog box, 71

grammatical errors, checking for, 76–77
graphic file formats, 672
graphic files, 679–680
graphics

brightness and contrast, 674–675
compressing, 677–678, 684
cropping, 676–677, 683
deleting cropped areas of, 678
file formats for, 672
handling in Office, 669–684
inserting in files, 672–674
inserting in Publisher, 635
lining up in Publisher, 627
obtaining on the Internet, 673
recoloring, 675–676
removing red eyes from, 683–684
replacing placeholder, 636
resizing, 684
rotating and flipping, 683
shape of, 677
for slide backgrounds, 401–402
as table backgrounds, 102–104
touching up, 674–677
wrapping text around, 635–636

greater than (>) operator, 597, 604
greater than or equal to (>=) operator,

597
Greeting Line button, 264
grid

hiding and displaying, 165
in PowerPoint, 426

grid guides in Publisher, 627, 628
gridlines

in charts, 108, 119–120
in datasheets, 585
printing on worksheets, 523
in a table, 88
in worksheets, 514

Gridlines check box on the View tab,
165, 426

Group buttons, 16–17, 172
grouping level for a report, 612
grouping objects, 164, 172–173
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groups
of commands on tabs, 16–17
handling e-mail, 333
in OneNote, 701
sending messages to, 322–324

Grow Font button, 42
gutter, 199

H
handouts

describing, 370
examples of, 445
printing, 446
providing, 445–446

hanging indent, 201
hanging relationship, 140–141
hanging shapes, 138, 139
hard line break, 412
hard page breaks, 198
harvestware, 347
header(s)

changing from section to section, 207
creating, editing and removing, 206
defined, 205
fine-tuning, 207–208
in handouts, 446
logo in, 208
for odd and even pages, 207
page numbers in, 204
putting on pages, 205–208
removing from reports, 614
removing from the first page, 207
on slides, 420
on worksheets, 523

Header & Footer button, 422, 423
Header & Footer command, 421
(Header & Footer Tools) Design tab,

205, 206
header row

cells, 101
changing text direction in, 101–102

in Excel, 525
ignored in sorting, 95
in a table, 88

Header Row check box, 98
Header/Footer tab, 523
heading(s)

in Outline view, 268, 270
as paragraphs, 195
viewing, 269

heading formats, 269
heading label, orientation of, 511
heading levels in a TOC, 271
heading rows, repeating, 233
heading row text, orientation of, 234
height

adjusting for worksheet rows, 513
scaling worksheets by, 521

Height boxes for objects, 165
Height text box, 93, 94
hidden folders, 226
hidden format symbols, 54, 186
hidden slides, 390–391
Hide Columns in Access, 584
hiding

columns or rows in Excel, 481
worksheets, 486

hierarchy diagrams
about, 130, 131, 132
adding shapes, 134
adding shapes to, 136–141
promoting and demoting shapes in, 141

High Importance button, 324
Highlight Cells Rules option, 471
Highlight marks, 250
highlighters

drawing with, 701, 702–703
erasing drawings of, 444
wielding in presentations, 443

highlighting documents, 249–250
high-resolution images, 671
Home page of a SharePoint Services Web

site, 710
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Home tab
Align Text button, 417
Borders button, 517
buttons on, 36
Cell Styles button, 515, 516
Change Case button, 47
Change Styles button, 219
Clear All Sorts button, 592
Clear button, 484
Clear Formatting button, 39, 43
Conditional Formatting button, 471
Convert to SmartArt button, 143
Delete button, 386
Find & Select button, 477
Font drop-down list, 40
Font group button, 40
Format Painter button, 39
Grow Font and Shrink Font buttons, 42
Increase Indent or Decrease Indent

button, 200
Line Spacing button, 208
Merge & Center button, 512
Multilevel List button, 212
number-formatting buttons on, 470
Numbering button, 211
Numbering or Bullets button on, 210
Orientation button, 510
Paragraph group button, 196, 208
Paste button, 731
on the Ribbon, 13–14
Show/Hide¶ button, 54, 213, 276
Styles group button, 219
Underline button, 45

horizontal axis
on a chart, 108, 109, 119
labels, 116
title, 116

horizontal diagrams, 144, 145
horizontal rules, 642–643
horizontal (side-by-side) space, 168
horizontal (side-to-side) alignment, 510
horizontal text box, 413
horizontally oriented diagrams, adding

shapes to, 136–137

.htm file extension, 664, 665, 666
HTML, 30, 329
.html file extension, 664, 665, 666
hue, 682
hybrid buttons with an arrow, 17
Hyperlink button, 56–57, 58, 59
Hyperlink character style, 271
Hyperlink data type, 560
hyperlinks, 560

creating, 55–60
description of, 56
in a file, 58–59
including as well as a cross-reference,

280
linking to a Web page, 56–57
repairing and removing, 59–60

hyphenating documents, 214–216

I
icons in this book, 4–5
ignoring, misspelling, 72
images. See graphics
Import and Export Wizard, 300
Import Objects dialog box, 556
Import to Collection dialog box, 693
Inbox folder, 333, 335, 339
Inbox window

changing views in, 337–342
color-coded flags in, 338
reading e-mail messages in, 332–335
rearranging or sorting messages, 337

incoming files, opening or saving, 336
Increase Decimal number format, 470
Increase Font Size button, 411
Increase Indent button, 212
Indent button (for left-indents), 200
indented index, 277
indents

compared to margins, 199
defined, 200
eye-balling with the ruler, 201

Indents and Spacing tab, 202
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Index dialog box, 276–278
index entries, marking in documents,

275–276
index field markers, 278
Indexed property for fields, 567
indexes, 276–278
indexing

in Access, 570–573
documents, 273–278
fields, 571–573

initial capitals, 66
initial diagrams, 131–133
ink color, drawing on slides, 443
inline with text, inserted objects as, 235
input cells, 531–532, 533
input masks, 565
Insert Address Block dialog box, 263–264
Insert button, 49, 325
Insert Caption button, 278
Insert Chart dialog box, 110
Insert Citation button, 284
Insert Endnote button, 280
Insert File dialog box, 325
Insert Footnote button, 280
Insert Function button, 462, 508
Insert Function dialog box, 508
Insert Function dialog button, 504, 505
Insert Greeting Line dialog box, 264–265
Insert Hyperlink dialog box, 57, 58
Insert Index button, 276–278
Insert Merge Field button, 265
Insert Movie dialog box, 434
Insert Options button, 512
Insert Outline dialog box, 382
Insert Picture dialog box, 104, 325–326,

672–674
Insert Shapes gallery, 152–153
Insert Sheet button, 485
Insert tab

Bookmark button, 190, 276
Clip Art button, 686
Movie button, 434
Object button, 736

Page Number button, 203
Picture button, 672
on the Ribbon, 14
Shapes button, 158
SmartArt button, 132
Table button, 89, 233

Insert Table dialog box, 88
inside margin, 199, 200
Installed Templates button, 182
Integer field size, 564
interactive presentations, 448–450
interface of Office 2007, 12–21
internal margins for text frames, 415
Internet connection for research, 78
in-text citations. See citations
italic, 39
italic font style, 42
items

categorizing in Outlook, 294–296
in Outlook folders, 292–293

J
JavaScript source files (.js), 336
join lines, 600
JPEG images, 672
junction table, 574
junk e-mail, 338, 346–348
Junk E-Mail folder, 344
Junk E-Mail Options dialog box, 345

K
keyboard shortcuts

assigning to macros, 719
customizing in Word, 657–659
defined, 657–658
getting around in a data sheet, 583
for going from slide to slide, 440–441
moving in worksheets, 476
in Office 2007, 20–21

KeyTips, 21
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L
labels

creating, 262
finishing touches on, 265
printing, 266

Labels button, 259
landscape documents, 246–247
landscape mode

aspect ratio in, 683
for handouts, 446
presenting tables in, 234
printing in, 519

landscape-style graphics, 402
Language dialog box, 83
language for an index, 277
lassoing objects, 164
Last Column check box, 98
Last function, 607
Last Viewed command, 442
layout(s)

from an index, 278
for Photo Album slides, 388
in Slide Master view, 406
for slides, 383

Layout button in PowerPoint, 383
layout elements of a chart, 116
layout guides, 626–630
Layout tab

adjusting rows and columns, 93
AutoFit button, 234
Cell Size group button, 93
changing a chart’s appearance, 114
Merge Cells button, 92
Select button, 91
Split Cells button, 92

Layout view, 615
leaders, 214, 271, 277
leave-behinds. See handouts
left tab, 213
left-aligned text, 510
left-indent marker, 201

legend, 108, 109, 116, 117
less than (<) operator, 597, 604
less than or equal to (<=) operator, 597
Limit Consecutive Hyphens To box, 215
line(s)

adjusting spacing between, 208–209
arrowheads on, 155–156
breaking, 198
changing the appearance of, 154–155
choosing for borders, 243
between columns, 240
decreasing spacing between in text

frames, 415
drawing, 152–153
erasing, 444
handling, 153–157
indenting first, 200–202
making consistent, 155
manipulating, 162–173
selecting, 187
in Word documents, 232

line breaks, 186
line caps, 154, 155
line chart, 112
Line Spacing button, 208
Line Style drop-down list, 99
Line Width drop-down list, 99
Linear gradient, 398, 399
Line/Border Style button, 645
linked content, 452
linked object, 729
linked styles, 219
linking

files, 728
pitfalls of, 730
uses for, 729

links
breaking and reestablishing, 733
breaking for text boxes, 242
establishing, 731–732
updating, 732

list diagrams, 130
list styles, 219
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lists
alphabetizing, 267
automatic, 211
constructing, 525–526
ending, 210
entering, 467–469
filtering, 527–529
indenting, 210
managing information in, 525–529
numbering, 420
sorting, 526–527
turning into tables, 233–234

live e-mail addresses, 346
live previewing, 18–19
Lock Aspect Ratio check box, 166
Logarithmic Scale check, 119
logo

in headers or footers, 208
placing on each page in Publisher, 646

Long Integer field size, 564
Look In drop-down list, 26
lookup data-entry list, 568–570
lookup fields, 556
Lookup Wizard, 569, 570
Lookup Wizard data type, 561
Loop until Next Sound option, 428
lossless compression, 672
lossy compression, 672
Lotus Organizer, 300
Low Importance button, 324
lowercase, 47
low-resolution images, 671

M
Macro Recorder, 718
macro viruses, 716
macros

in databases, 542
deleting parts of, 724
editing, 722–723
naming, 719
reading in the Code window, 723
recording, 718–721

running, 721–722, 724–725
security problems, 716–718
storing, 720
viewing, 722

Macros button, 721, 722
Macros dialog box, 721
Mail Merge Recipients dialog box, 263
Mailbox Cleanup command, 303–304, 338
Mailings tab

Envelopes button, 257
Labels button, 259
Preview Results button, 264
Start Mail Merge button, 262

main entry in an index, 274, 275
major gridlines, 120
Manage Sources button, 285, 286
Manage Templates button, 123
manual hyphenation, 215
manual lists, 732
manual page breaks, 520, 521
many-to-many relationships, 574
Map button in the Contact window, 309
mapping graphic files, 679–680
margin guides, 627, 628
margins

adjusting worksheet, 522
choosing for reports, 615
setting up and changing, 198–200

Margins button, 199–200, 522
Mark All button, 276
Mark Entry button, 275
Mark Index Entry dialog box, 274
Mark Table of Contents Entry dialog box,

274
markup, deleting on slides, 444
markup language, 30
marquee lights, 494, 495
mass mailings, 260–266
master page, 646–647
master slide layout, 407
master slides, 404–405, 406, 407
master styles, 404–405, 406

editing, 406
in PowerPoint, 385
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Master view in Publisher, 646
master views in PowerPoint, 385
Match Case box, 51
Match Case check box, 588
Match Fields dialog box, 264
math formulas in Word tables, 100–101
matrix diagrams, 130, 136
Max function in Access, 606
MAX function in Excel, 504
.mdb extension, 546
media files

cataloging, 694
handling with the Clip Organizer,

688–696
inserting, 691
locating in Collection List, 691
locating with Clip Organizer, 689–691
organizing in My Collections, 695

Medium Booklet Style, 311
meetings, scheduling, 351
Memo data type, 560
Memo field, 584
Memo Style, 311
menu items, KeyTips appearing on, 21
menu-and-toolbar structure, 12
Merge & Center button, 512
Merge Cells button, 92
Merge to New Document dialog box, 266
merging, 91–92, 260–261
Message Options dialog box, 327
Message window, 316, 339
messages. See e-mail messages
.mht file extension, 664, 665
.mhtl file extension, 664, 665
Microsoft

clip art from, 400, 692
Excel templates online, 459
media files from, 690
publication designs online, 621
templates online, 374

Microsoft Access Application files
(.mdb), 336

Microsoft Clip Organizer. See Clip
Organizer

Microsoft Office Picture Manager. See
Picture Manager

Microsoft Office Suite. See Office 2007
Microsoft Office 2007 Language Settings

dialog box, 82
Microsoft OneNote. See OneNote
Microsoft Outlook. See Outlook
Microsoft Product Information Center,

obtaining language-proofing
software, 82

Microsoft Word. See Word
.mid extension, 431
.midi extension, 431
MIDI Sequence file, 431
midtones, adjusting, 682
Min function in Access, 606
MIN function in Excel, 504
Mini Toolbar

Bold and Italic buttons, 43
changing fonts, 39, 40
changing font size, 42
choosing a font color on, 46
description of, 19

Minimize button, 180
Minimize the Ribbon option, 14
minor gridlines, 120
minus icon in Outline view, 269
Mirror Margins option, 200
misspellings

correcting, 70, 72
placing in the AutoCorrect dialog box,

66
.mlb file extension, 31
Modern style set, 219
Modify Style dialog box, 224–225
modules, 539, 540, 542
month, going to a different, 351
mortgage, monthly payment, 529–530
mouse, avoiding in recording macros,

720
mouse wheel, 63
“mouse-over” hyperlinks, 449, 450
MOV (QuickTime Video) video format,

434
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Move Chart button, 113
Move or Copy dialog box, 485
Move to Collection command, 695
Move to Folder button, 343
Movie button, 434
Movie Options group button, 435
moving

columns or rows in tables, 96–97
endnotes or footnotes, 283
fields, 562
notes, 706
objects, 166
pages in Publisher, 639
slides, 386
tables, 90
text, 36

MP3 audio file, 431
.mp3 extension, 431
MPEG (Motion Picture Experts Group)

video format, 434
MPG (Media Planning Group) video

format, 434
MSN Money Stock, 78
MSN Search, 78
MSN Spaces, 667
multifield index, 571, 572–573
multilevel lists, 212
multiple-field primary key, 562
My Collections folder, 691, 692–696
My Collections, searching, 690
My Collections subfolder, 695–696
My Computer, 28
My Documents folder, 22
My Pens toolbar, 702–703
My Recent Documents button, 26
My Templates button, 182
My Templates tab, 226

N
Name box in Excel, 476, 477
Name Manager button, 498

naming
cell ranges in Excel, 496–498
macros, 719

Navigation button in Access, 587
Navigation pane

in Access, 544–545
hiding and displaying, 291, 335
manipulating, 545
in Outlook, 290, 291, 292

Navigation Pane buttons, 289–290
navigator buttons in Word, 189
nested lists, 212
New Appointment button, 353
New button

in the Custom Dictionaries dialog
box, 74

in OneNote, 699, 700
for a task, 360

New Command in the Records group,
583

New Comment button, 250
New Contact button, 306
New Document dialog box, 181
New E-Mail Message button, 316
New from Existing Document dialog box,

182
New Item Alerts window, 341
New Note button, 364, 365
New Presentation dialog box, 373
New Query dialog box, 599
New Record button, 583, 587
New Style button, 222–224
New Window button, 64
New Workbook dialog box, 458
News Flash transition, 427
newspaper-style columns, 239–240
Next Page section break option, 196
No Formatting button, 52
nonstandard footer, 422–423
Normal style, 219
Normal template, 217, 225
Normal view

entering text in, 409, 410
in PowerPoint, 383, 384
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Northwind 2007 sample database, 537
not equal to (<>) operator, 597
Not operator, 604
Note Flags Summary task pane, 705
notebooks

creating, 698, 699–700
going to different, 703
removing from the Navigation bar, 706

notes. See also endnotes; footnotes
copying into other Office programs, 707
finding and keeping track of, 703–706
flagging, 704–705
forwarding, 364
making to yourself, 364–365
in PowerPoint, 370, 373
for presentations, 437–438
printing, 437
sending by e-mail, 707
for speakers, 437–438
storage units for, 699–701
taking, 697
transferring to Word, 707
turning into an Outlook task, 708
typing, 701
writing, 701–703

Notes button, 364–365
Notes Page button, 437
Notes Page view, 384, 437
Notes pane

hiding and displaying, 385
in PowerPoint, 437–438
on the PowerPoint screen, 372

notes receptacle, Outlook as, 290
Notes window, 364–365
Nudge commands, 166
null value, 561, 588
number(s)

aligning in worksheet columns and
rows, 509–511

crunching in Excel, 489–508
displaying in Excel cells, 113
entering into tables, 90
formatting in charts, 127

formatting in Excel, 469–471
large on a chart, 119

Number data type, 560
Number fields, 564
number formats, 469–471
Number group button, 470
Number tab, 465
numbered lists

choosing style, size and color for, 420
creating in PowerPoint, 418
resuming, 210

numbering pages in Word, 202–205
numbering schemes

for footnotes or endnotes, 282–283
for lists, 211, 420

numeric criteria for a query, 603–604
numeric values in worksheets, 463–464
numerical and date axis options for

charts, 118

O
object(s)

in Access, 538, 539, 540
adding to a group, 173
aligning and distributing, 166–169
aspect ratio of, 166
changing size and shape of, 165–166
copying, 545
creating, 544
defining, 235
in Design Gallery, 647
distributing to be equidistant, 168
examples of, 163
fill and outline color for, 176
filling, 174–175
finding, 545, 548
grouping, 164, 172–173
manipulating, 162–173
moving and positioning, 166
opening, 545
outlines around, 175–176
overlapping, 163, 169–170
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positioning and wrapping, 235–237
in Publisher, 624
regrouping, 173
removing outlines from, 176
rotating and flipping, 171
selecting for manipulation, 164
in a stack, 170
transparent, 170
ungrouping, 173
wrapping text around, 235–236

Object button, 736
object linking, 728
object linking and embedding. See OLE
Object (or Insert Object) dialog box, 734
object shortcuts, 548
object types in the Navigation pane, 544
Odd Page section break option, 196
Office 97-2003

converting to 2007, 24
saving files for use in, 23

Office 2007
about, 9–10
interface of, 12–21
keyboard shortcuts, 20–21
language settings, 82
starting programs, 10–12

Office button, 13, 181, 370, 372
Office Clipboard icon, 38
Office Collections folder, 691
Office Collections, searching, 690
Office files, saving as Web pages,

664–666
Office programs

OneNote and, 707–708
opening Clip Organizer from, 688
starting automatically, 12

OLE Object data type, 560
OLE (object linking and embedding),

727–730
One Note 2007, description of, 10
one-input table, 530–532
OneNote

introduction to, 698–699
navigating in, 703

Office programs and, 707–708
running, 697–698
saving automatic in, 699

OneNote Sections (.one) file, 701
one-slide-per-minute rule, 376
one-to-many relationships, 574
one-to-one relationships, 574, 578
Open button, 337
Open dialog box, 26
open format, XML as, 30
Open Item button, 363
Open Saved Search dialog box, 297
Open Source button, 733
opening files, 26–28
operators in formulas, 492–493
Options button, 22
Options tab, 327
OR search, 596, 597
order of precedence for formulas, 493
Order toolbar, 639
organization charts, 138–141
Organizer, 228
organizing e-mail messages, 337–342
orientation

of handouts, 446
of heading labels, 511
of heading row text, 234

Orientation button
on the Home tab of Excel, 510
on the Page Layout tab, 519

original files, 25
OSS (Office Saved Searches) extension,

297
outline(s)

changing for a diagram shape, 147
for organizing work, 268–270
putting around objects, 175–176
removing from objects, 176

Outline button
on the status bar, 268
on the View tab, 184, 268

Outline tab
in PowerPoint, 383, 384
in the Slides pane, 382
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Outline text effect, 45
Outline view, 184, 185

reading comments in, 250
rearranging document sections,

269–270
switching to, 268

Outlining tab, 268, 269
Outlook

addresses from, 263
color scheme for, 657
description of, 9
making the default e-mail program, 318
navigating folders, 290–291
purposes of, 289–290
turning notes into tasks, 708
using a language besides English, 82

Outlook blocked access to the following
potentially unsafe attachments
message, 336

Outlook Calendar. See Calendar
Outlook Express, 300
Outlook Today button, 291
Outlook.pst file, 298–300
outside margin, 199, 200
overflow text

in Publisher, 632–633
in text boxes, 416

overlapping
frames, 638–639
objects, 163, 169–170

overlay chart, 126–127

P
Pack and Go command, 649
Package for CD command, 431, 435,

450–452
packaged presentations in PowerPoint

Viewer, 453
packaging presentations, 450–453
page(s)

backgrounds for in Publisher, 645–646
decorating in Publisher, 644–646
decorating with borders, 242–243

deleting in OneNote, 706
entering text on, 631–632
frames on Publisher, 636–638
going to different in OneNote, 703
headers and footers on, 205–208
inserting, removing, and moving in

Publisher, 639
keeping some from being numbered,

205
moving in OneNote, 706
for notes, 700–701
numbering in Word, 202–205
numbering with Roman numerals, 270
within OneNote sections, 699
positioning objects on, 236–237
starting new, 198
tables on, 234
worksheets on, 519–522

page backgrounds in Publisher, 646–647
Page Borders button, 242
Page border tab, 243
page breaks, 520–521
Page Layout tab

Breaks button, 196, 198, 240
experimenting with themes, 238
Hyphenation button, 215
Margins button, 199–200
Page Borders button, 242
Print Titles button, 524
Scale to Fit options on, 521
Watermark button, 245

Page Layout tabs on the Ribbon, 14
Page Layout view, 519
page navigation buttons, 626
page number(s)

aligning in a TOC, 271
changing formats, 204–205
chapter numbers in, 204–205
formatting in an index, 276
on handout pages, 446
in a header or footer, 204
including in cross-references, 280
in reports, 614
right aligning in an index, 277
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in a TOC, 271
on worksheets, 523

Page Number button, 203
Page Numbers dialog box, 614, 615
page range in an index, 276
page references in an index, 274, 275–276
Page Setup dialog box

describing, 246–247
on the Format tab, 313
Margins tab, 199–200, 522
opening, 522, 523

page size in Publisher, 624
paper clip icon, 335
paper forms, examining an

organization’s, 547
paper, printing on different sizes, 247
Paper tab, 247
paragraph(s)

formatting, 195–196
horizontal rules on, 643
hyphenating, 216
indenting, 200–202
objects connected to, 237
selecting, 35, 187
space between lines, 209
styles from, 222

paragraph breaks, 186
Paragraph dialog box, 202
Paragraph group button, 196, 208
paragraph styles, 218, 273
paragraph text, 269
parentheses in formulas, 493
password(s)

case sensitivity of, 32
entering to unprotect a worksheet, 487
locking files with, 31–33
removing from files, 33

Paste button, 36, 731
Paste Link option button, 731
Paste Name dialog box, 496, 498
Paste Options button, 37, 484
Paste Special Command, 463
Paste Special dialog box, 731, 735
Path gradient, 398, 399

patterns
applying to objects, 175
choosing for shape outlines, 176

Pause Recording button, 720
PDF (Portable Document File) format,

662–663
pen(s)

drawing with, 701, 702–703
erasing drawings of, 444
wielding in presentations, 443

Pen Color button, 99
pencil icon, 583
Percent Style number format, 470
percentage

highest or lowest by, 606
scaling worksheets by, 521

Personal Folders, 291
Personal.Macro Workbook, 720
persuasive presentations, 375–378
Phone Directory Style, 311
photo album

creating, 387–389
editing, 390
putting together, 386–390

photos
on a Contact form, 307
inserting in presentations, 425
making black and white, 389
in Word documents, 232

phrases, translating to a foreign
language, 83–84

picture(s)
for bullets, 419–420
decorating charts with, 123–124
editing in Picture Manager, 681–684
in e-mail messages, 325–326
filling objects with, 174–175
in objects, 174
in a photo album, 387–388
in Photo Album, 389
in Publisher, 637
rotating in Photo Album, 389
as table background, 102–104

Picture button, 672
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picture file formats, 669–672
picture frame in Publisher, 637
picture layouts in Photo Album, 388
Picture Manager

describing, 10, 678–684
views in, 680

picture watermark, 245
pie chart, 112
pinning names on the Recent Documents

list, 28
pixels per inch (ppi), 671
placeholder graphics, 636
Placeholder Name dialog box, 284–285
plain text format, 329
Play Reminder Sound check box, 364
plot area, 108, 122
plus icon in Outline view, 269
PM time designation, 467
PMT function, 529–530
pointer. See also cursor

moving over the Mini Toolbar, 19
point-size measurement, 209
pop-up descriptions of buttons, 17
portrait document, 246
Portrait mode, 683
Position button, 113, 236
Position commands, 236–237
positioning

diagrams, 133
frames in Publisher, 638

poster, frames forming, 620, 621
pound signs (###) in an Excel cell, 463
PowerPoint

aligning text in columns and rows, 91
background picture in each table cell,

104
changing case in, 47
changing the size of a table, 93, 94
Chart button, 110
choosing a color scheme for, 657
creating tables, 88–89
description of, 10
Developer tab in, 715–716

getting acquainted with, 370, 371
getting started, 369–391
macros in, 718
playing sound files, 433
positioning charts in, 113
Replace command in, 55
screen, 370, 372
status bar, 656
tour of, 373
using a language besides English, 82
window, 370, 371

PowerPoint Viewer, 451, 452, 453
ppi (pixels per inch), 671
.pptm extension, 31, 718
.pptx files, 31, 370
precedence for formulas, 493
precedents, tracing in Excel, 503
“prefabricated” page numbers,

202, 203–204
prefabricated watermark, 245
prefixes, 51
preformatted text box, 241
Premium Content icon, 78
presentations

blanking the screen on, 444–445
borrowing themes from, 395, 396
building persuasive, 375–378
choosing fonts for text, 410
choosing themes for, 395–396
creating, 373–375
delivering, 373, 437–453
describing, 370
designing, 373, 375–376
distributing to people without

PowerPoint, 452
enlivening, 425–426
entering text into, 409–412
making livelier, 442–445
packaging, 431, 450–453
personalizing, 376
recycling, 374
rehearsing and timing, 438–439
self-running, kiosk-style, 446–448
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separated from the sound file, 431
showing, 440–442
showing hidden slides during, 390–391
slides for, 378–383
starting and ending, 440

preset columns, 240
Preview Results button, 264
Preview view, 27
previewing before printing, 662
primary button, 14
primary key field, 539, 540

designating, 561–562
for each database table, 550–551

Print Area button, 519
Print button, 311
Print dialog box, 311–312, 662
Print Layout and Web Layout view, 252
Print Layout view, 183, 184

columns appearing in, 239
determining where sections end, 197
entering footnotes or endnotes, 280
handling page numbers in, 202
reading comments in, 250
seeing drop caps in, 244
seeing headers and footers, 205

Print Preview screen, 523
Print Preview tab, 662
“a print shop in a can”, 619
Print Titles button, 524
printed pages for contacts, 312–313
Printed Watermark dialog box, 245–246
printing

the Contacts folder, 310–313
on different sizes of paper, 247
distributing work by, 661–662
feeding envelopes during, 258
notes for presentations, 437
publications commercially, 648–649

prioritizing e-mail messages, 324
process colors (CMYK), 648, 649
process diagrams, 130, 136
PRODUCT function, 504
programs in Office 2007, 9–10

Promote button, 270
promoting, shapes in hierarchy

diagrams, 141
Proofing category, 659
proofing text in a foreign language, 82–83
proofing tools

obtaining from Microsoft, 82
in Office, 69–85

Properties dialog box, 30
Properties pane, 29
Properties view, 30
Protect Sheet dialog box, 486–487
.pub file extension, 31
public domain, clip art in, 685
publication designs, 619

choosing different, 622–623
examples of, 619, 620
selecting, 621

publications
beautifying, 641–649
creating, 620, 621–622
navigating from page to page in, 626
printing commercially, 648–649
redesigning, 622–624
refining in Publisher, 631–638
starting from another, 622

Publish As Web Page dialog box, 665
Publish button on the Blog Post tab, 668
Publisher. See also desktop publishing

description of, 10
getting around in, 624–626
introduction to, 619–630
using a language besides English, 82

punctuation in sentences, 51
pyramid diagrams, 130

Q
QAT. See Quick Access toolbar
queries

creating new, 599
criteria for, 603–605
describing, 539, 540
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queries (continued)

for getting data out of databases,
541–542

kinds of, 605–609
requiring relationships between tables,

573–574
saving and running, 605

query builder search in Outlook, 297
Query Design window, 599, 599–600
Query grid, 602
query results, 601–603
Query Wizards, 599
querying, 598–605
Quick Access toolbar

about, 13
above or below the Ribbon, 654, 656
adding buttons to, 654–655
customizing, 653–656
macros from a button on, 724–725
on the PowerPoint screen, 370, 372
removing buttons from, 655
Repeat button, 62
Undo buttons, 62
on the Word screen, 179

Quick Launch toolbar, 11–12
Quick Print option, 662
“quick-clicking” in the Category column

of Outlook, 291

R
radar chart, 112
Radial gradient, 398, 399
ragged right margin, 214
random numbers, generating, 562
range, changing a scale’s, 118
range name, as part of a formula,

497–498
Range Selector buttons, 524
ranking number, highest or lowest by,

606
raw data

for a chart, 112–113
displaying alongside a chart, 126

.rctrx extension, 123
Read Receipt, 329
readability of presentations, 411
Reading Highlight button, 50
Reading pane

about, 332
hiding and displaying, 291, 292, 333
moving, 359

receiving e-mail messages, 331–335
Recent Documents list, 28
Recent Documents menu, 714
Recently Used Symbols, 49
Recipient Read message box, 328
recoloring

clip-art images, 688
graphics, 675–676

recording macros, 718–721
records, 539, 540

in database tables, 539
deleting from forms, 587
deleting from tables, 609
finding missing, 588–589
sorting in database tables, 591–592
updating in several tables, 609

Rectangular gradient, 398, 399
Recurrence button

in the Appointment window, 354
in the Task window, 361

recurring appointments, 351, 354
recurring events, 351, 353, 354
recurring tasks, 361
recycling

documents, 191
presentations, 374
slides, 381
workbooks, 459

red eyes, removing, 683–684
red lines, getting rid of, 71
redesigning publications, 622–624
Redo button, 62
reestablishing links, 733
References tab

Bibliography button, 286
Cross-reference button, 279
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Insert Caption button, 278
Insert Citation button, 284
Insert Footnote button, 280
Insert Index button, 276
Manage Sources button, 285–286
Mark Entry button, 274
opening the Style drop-down list, 286
Table of Contents button, 270

referential integrity, 577
Regroup command, 173
regrouping objects, 173
regular font style, 42
Rehearsal toolbar, 438
rehearsing

presentations, 378, 438–439
self-running presentations, 447

Reject button for revisions, 257
relational database, 539, 540

Access as, 548, 548–550
relationship diagrams, 130, 136
Relationship window, 575–576
relationships

between database tables, 573–579
between tables, 551–552
types of between tables, 574–575

Reminder message box, 339–341,
362–363

reminders
about activities and tasks, 362–364
customizing, 364
setting, 354

Remove Arrows button, 503
removing

hyperlinks, 60
pages in Publisher, 639

Rename button in the Color Categories
dialog box, 295

Rename Page dialog box, 626
renaming

fields, 562
files in the Open dialog box, 27
styles, 227
worksheets, 484

renaming fields, 562
repairing hyperlinks, 60
Repeat button, 13

on the Quick Access toolbar, 62
on the Word screen, 179, 180

Repeat command, 61–62
creative uses for, 62
inserting rows or columns, 512

Repeat Header Rows button, 233
Replace All button, 55
Replace command, 49
replacing data in Access, 589–590
Replication ID field size, 564
Reply button in the Message window,

318–319
replying to e-mail messages, 321
Report Design window, 614–615
Report Wizard, 612–613
reports, 539, 540

creating, 611–613
opening and viewing, 613
presenting and examining database

data, 542
presenting data in, 611–616
reviewing, 612, 613
tweaking, 613–616

reports (scholarly), tools for, 267–286
Request a Delivery Receipt check box,

328
Request a Read Receipt check box, 329
Required property for fields, 567
rescheduling activities in Calendar, 356
Research Task pane

choosing synonyms and antonyms, 81
describing, 77–80
translating words or phrases, 84

researching inside Office programs,
77–80

Reset command, 383
Reset Graphic button, 145
Reset Picture button, 675
Reset Window Position button, 64
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resizing
diagrams, 133
frames in Publisher, 638
graphics in Picture Manager, 684

resolution, 671
Restore button, 180
Reuse Slides task pane, 381
Reveal Formatting task pane, 197
Review tab

Balloons button in, 252
Compare button, 255
New Comment button, 250
Previous or Next button, 257
Protect Sheet button, 486
Research button, 79
Set Language button, 75, 83
Spelling & Grammar button, 76
Spelling button, 70
Thesaurus button, 81
Track Changes button, 253
Translate button, 83
Translation ScreenTip button, 85
Unprotect Sheet button, 487

reviewers, revisions by, 257
Reviewing pane button, 251
revision marks

making changes, 255–256
reading documents with, 254

revisions
accepting, 257
accepting or rejecting, 254, 256–257
marking, 253–254
tracking to comments, 252–257

Ribbon, 13–14
context-sensitive tools on, 15–16
minimizing, 14
placing the Quick Access toolbar above

or below, 654, 656
on the PowerPoint screen, 370, 372
on the Word screen, 180

rich text format, 329
right tab, 213
right-aligned text, 510

right-clicking, 20
right-indent marker, 201
RM (RealVideo) video format, 434
Rotate commands, 171, 683
rotating text boxes, 413
rotation handle, dragging, 171
row(s)

aligning text in, 91
calling attention to in tables, 98
changing the size of, 93–94, 512–514
in a datasheet, 582
freezing and splitting, 478–481
hiding, 481
inserting and deleting, 96, 511–512
inserting new, 90
moving in tables, 96–97
selecting, 91, 483
in worksheets, 459, 460, 461

row colors in datasheets, 585
row headings, repeating on each page,

524
Row Height dialog box, 513
row input cell, 533
Row Input Cell text box, 534
row labels in tables, 88
row numbers, printing on worksheets,

523
ruler(s)

changing margins on, 200
eye-balling indents, 201
hiding and displaying, 164–165
in Publisher, 629

Ruler check box, 164
ruler guides

drawing in Publisher, 628–630
moving in Publisher, 630
in Publisher, 627, 628
removing in Publisher, 630

rules for earmarking messages, 341
Rules Wizard, 342
run-in index, 277
running queries, 605

57_782793 bindex.qxp  11/27/06  9:29 AM  Page 770



Index 771

S
Safe Senders list, 345
saturation, 682
Save As dialog box, 25, 31
Save As Template button, 122
Save button

about, 13
clicking, 21
in the Opening File Attachment dialog

box, 336
on the Quick Access toolbar, 317
on the Word screen, 179, 180

Save Files in This Format drop-down
list, 23

saving
files in Office, 21–25
queries, 605

scale in a chart, 118, 127
“scaling to fit” a worksheet, 521–522
schedules, views of, 356
scheduling

reminder messages, 363
types of, 350–351

scholarly papers, tools for, 267–286
screen

blanking in presentations, 444–445
splitting in Word, 185–186

ScreenTips, 57, 58
scroll bars

in Excel, 476
on the Word screen, 180

scroll wheel on the mouse, 476
scrolling synchronous, 64
Search box in OneNote, 705
Search commands, finding e-mail

messages, 338
Search Contents text box, 310
search criteria in Outlook, 297
Search Fields As Formatted check box,

588
Search Folder box in Outlook, 296, 297
Search pane in Clip Organizer, 689–691

searches
narrowing, 51
in Outlook, 296–297
saving in Outlook, 297
with wildcard operators, 52–53

secondary e-mail addresses, 347
section breaks, 196–197
sections

deleting, 706
going to different, 703
moving, 269
in notebooks, 699
for notes, 700–701
rearranging, 269–270

security problems with macros, 716–718
Select All button, 481
Select Browse Object button, 188
Select button, 91
Select Members button, 323
Select Names dialog box, 318, 319
select query, 605
Select Recipients button, 262
Select Text with Similar Formatting

command, 36
selecting

cells in tables, 91
columns in tables, 91
notes, 706
objects for manipulation, 164
rows in tables, 91
slides, 385–386
tables, 90, 91
text, 35–36

Selection button in the Sort & Filter
group, 593, 595

selection, filtering by, 595
selection handles

for objects, 164
and shape, 159
on shapes at connecting locations, 156

self-running, kiosk-style presentations,
446–448

Send Backward command, 170
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Send Behind Text Command, 170
Send button, 317
send date, postponing for, 327
Send to Back command, 170
senders, 345
Send/Receive Groups dialog box,

331, 333
Sent items folder, 317
sentences

capitalizing the first letter of, 66
case of, 47
selecting, 187

sequential numbers, generating, 562
serial data in Excel, 467–469
serial values, converting dates and times

to, 464
Set Hyperlink Screen Tip dialog box, 58
Set Language button, 75, 83
Set Quick Click dialog box, 295
Set Up Slide Show button, 448, 450
Shading button, 100, 104
Shadow text effect, 44
shape(s)

adding to diagrams, 135–136
changing a graphic’s, 677
combining, 158
connecting, 156–157
drawing, 152–153, 158–159
enlarging for text, 161
entering text on, 142–143
hanging below shapes, 140–141
inserting in presentations, 373, 426
manipulating, 162–173
in an Organization Chart diagram, 138
promoting and demoting, 141
removing from diagrams, 135
as text boxes, 160–161
turning into text boxes, 413
turning text boxes into, 413
in Word documents, 232

Shape Effects button, 147
shape fill, 173

Shape Fill button, 147
on the (Chart Tools) Format tab, 123
on the (Drawing Tools) Format tab, 106
on the Format tab, 174–175

Shape Outline button, 106, 147, 154, 176
Shape Styles gallery, 155, 173
Shapes button, 125, 152–153, 158
Shapes gallery, 158
Shared Documents folder, 711–712
SharePoint Services, 709–710
SharePoint Services Web site, 709–710

gaining entry to, 710–711
navigating, 711
uses of, 714

Shift+Enter, 198, 412
Shift+F1, 197
Shift+F2, 482, 584
Shift+F3, 48
Shift+F5, 188
Shift+F7, 80
Shift+F9, 426
Shift+F11, 485
Shift+Spacebar, 483
Shift+Tab, 587
shortcut icons

for Office programs, 11–12
on the Quick Launch toolbar, 12
on the Windows desktop, 28

shortcut keys in Word, 187–188
shortcut menu

changing fonts, 39
changing font size, 42
right-clicking to open, 20

shortcuts
for applying styles, 219
for selecting text in Word, 186–187

Show All Comments button, 481
Show All Formatting Marks check box,

197
Show Data Picker property, 568
Show Formulas button, 501
Show Formulas on the Formulas tab, 491
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Show Markup button, 251
Show Office Clipboard Automatically

option, 37
Show Source Documents button, 256
Show Table button, 600
Show Table dialog box, 576, 600
Show/Hide¶ button, 278

in the Home tab, 54
on the Home tab, 213, 276
symbols for, 186

showing presentations, 440–442
Shrink Font button, 42
Shrink Text on Overflow command, 633
Shutter Bar Open/Close button, 545
side notes, 702
signature, devising for e-mail messages,

330
Similarity button in the XP Fonts

folder, 41
Single field size, 564
Single File Web Page, 664–665
Single Picture view, 680
Size dialog box, 165, 166, 171
sketch, starting a diagram, 132
slash (/), starting AutoCorrect entries, 68
slide(s)

about, 370
aligning objects on, 167–168
animating, 373, 428–430
background of, 403–404
copying and pasting, 381
creating, 373
creating duplicate, 381
deleting, 386
drawing on, 442
footers and headers, 420
hiding, 390
inserting new, 378–381
inserting sound files on, 432
inserting video on, 434–435
jumping forward or backward, 442
moving, 386

moving between, 440–442
for a photo album, 387–388
playing video on, 434–436
for presentations, 378–383
recycling, 381
removing footers from, 423
selecting, 385–386
selecting different layouts for, 383
sound added to, 430–434
standard footers on, 422
for text, 415
titles from document headings, 381–382
transitions between, 427–428

slide backgrounds
creating, 397–403
placing a clip-art image in, 400–401
texture for, 402–403

slide control buttons, 440, 441
slide layouts, 378, 379–380, 381
Slide Master, 404, 406, 421
Slide Master button, 405
Slide Master view, 405, 422
slide numbers, 422, 423, 442
slide shows, 370. See also presentations
Slide Show tab

From Beginning button, 440
Hide Slide button, 390
Rehearse Timing button, 438
Set Up Slide Show button, 448, 450

Slide Show view, 384
Slide Show view button, 440
Slide Sorter view

in PowerPoint, 384
selecting slides in, 385–386
time periods for self-running

presentations, 447
slide timings, 439
slide transitions, sound as part of, 430
Slide window, 372
Slides pane, 372, 385
Small Booklet Style, 311
small caps, 44
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Smart Tags, 659–660
Smart Tags property, 567
SmartArt button, 132
SmartArt gallery, 145
SmartArt graphics, 129–131
snaking in columns, 239
snapping, 628
Snooze button, 363
Sort A to Z button, 592
Sort button

in Excel, 527
on the Home page, 267
on the (Table Tools) Layout tab, 95

Sort by Flag Status button, 338
Sort dialog box, 95, 527
Sort row of the Design grid, 601–602
Sort Text dialog box, 267
Sort Z to A button, 592
sorting, 539, 540

defined, 94
lists in Excel, 526–527
records in a database table, 591–592
a table in Word, 94–95

sound(s)
adding to slides, 430–434
adding to transitions, 428
playing in PowerPoint, 431–432
for a reminder, 364

Sound button, 432
sound files

inserting on slides, 432
keeping in the same folder as the

presentation file, 431
playing, 433
for PowerPoint presentations, 431
starting, pausing, and resuming, 434

Sound icon, 432
hiding and unhiding, 433
pausing and resuming sound, 434
placing on slides, 430

Sound Volume icon, 436
source file(s)

editing data in, 732
linking to, 731

for a mass mailing, 260
merging for mass mailings, 262–265
opening, 733
options for, 262–263
preparing for a mass mailing, 261–262

source formatting, 37
Source Manager dialog box, 285, 286
space

adjusting between lines, 208–209
adjusting between paragraphs, 209
between columns, 240
between words, symbol for, 186

spam, 344, 347
spamware, 346
Spanish, translating to English, 84
speakers

giving a presentation, 376
presentation notes for, 437–438

special characters in Word, 53–55
Special Characters tab, 216
speed techniques, 61–68

for entering formulas, 494–499
for inserting slides, 381
for opening files, 28
for opening My Computer files, 28
for opening Windows Explorer files, 28
for Word, 179–194

spell checker
e-mail messages, 317
fine-tuning, 72–75
running, 70–72

Spelling & Grammar button, 76
spelling dictionary. See dictionary
spelling errors, correcting, 69–75
splitting

cells in tables, 91–92
the Word screen, 185–186
worksheets, 478, 479

spot colors, 648, 649
spreadsheets. See worksheets
Square wrapping, 636
squiggly red lines, 71
standard footer on all slides, 422
Start button, 10
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Start Mail Merge button, 262
Start menu, 10–11
Start New Column box, 240
status bar

customizing, 656
Outline button on, 268
on the Word screen, 180

STDEV function in Excel, 504
StDev in Access, 606
STDEVP function in Excel, 504
stock chart, 112
Stop Recording button, 721
stories

telling a, 377
writing in Publisher, 631

Straight Connector, 157
strikethrough, 43
striped columns or rows in tables, 98
style(s)

applying, 219–220
applying to cells, 514
applying to text and paragraphs,

219–222
assembling from other templates, 226
coming with templates, 225
copying from different documents and

templates, 227–229
creating, 209, 222–224
deleting and renaming in templates, 227
modifying, 224–225
shortcuts for applying, 219
types of, 218
in Word, 217–219

Style dialog box, 272, 273, 516
Style drop-down list, 286
Style menus, 221–222
style sets, 219
Styles gallery, 218

applying styles, 219
removing style names, 221

Styles group button, 219
Styles window, 218, 219
subdatasheets, 579

in Access, 580

subentry in an index, 274, 275
subheadings, viewing or hiding, 269
Subject text box, 317
subpages

creating for notes, 700, 701
deleting in OneNote, 706
within OneNote sections, 699

subscript, 43
sub-subentry in an index, 274, 275
suffixes, 51
Suggestions box, 72
SUM function

example, 495
in Excel, 504

Sum function in Access, 606
summary query, 606–607
superscript, 43
surface Chart, 112
Switch Windows button, 64
symbols

for bullets, 419–420
entering, 48–49
for a footnote or endnote, 282

symmetry
changing a shape’s, 160
maintaining while cropping, 683

Synchronous Scrolling button, 64
synonyms, 80–81
system tray, 38

T
tab(s)

anatomy of, 16–18
at the bottom of worksheets, 459
context-sensitive, 15–16
describing, 212–214
on the Ribbon, 13–14
types of, 213

Tab key, 213
tab leaders

about, 214
for an index, 277
for a TOC, 271
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tab spaces
in lists, 233
symbols for, 186

tab stops, 213
table(s)

addresses in Word, 261
changing the size of, 90, 93–94
creating, 88–89
creating columns, 239
decorating with borders and colors,

98–100
describing, 576
drawing diagonal lines on, 104–105
drawing in Word and PowerPoint, 89
drawing on, 105–106
entering text or numbers into, 90
from Excel worksheets, 89
fitting on pages, 234
formatting, 97–100
inserting in presentations, 373, 425
jargon of, 87
laying out, 93–97
math formulas in Word, 100–101
moving, 90
selecting, 90, 91
sorting in Word, 94–95
turning into lists, 234
turning lists into in Word, 233–234
in Word, 232–234

table background, using a picture as,
102–104

Table button on the Insert Tab, 233
table cells, capitalizing first letter of, 66
Table Design button, 554
table entry fields in a TOC, 273
table frames, 637
table of contents. See TOC
Table of Contents button, 270
Table of Contents dialog box, 

270–271, 272
Table of Contents Options dialog box,

272, 273
Table pane, 599, 600
Table Size button, 93, 94

table structure, 556
Table Style Options check boxes, 98
table styles, 97–98, 219
Table Templates button, 555
Tablet PC, 701
Target Output options, 678
task(s)

attaching files to, 361
deleting, 362
editing, 362
entering in the Tasks window, 360–361
examining in the Tasks window,

361–362
handling and managing, 362
marking as complete, 362

task deadlines, reminders for, 363
Task List, 350
Task Recurrence dialog box, 361
task reminders

default time for, 364
Outlook as, 290

Task window, 291
Tasks window, 359–362
template(s)

in Access, 543–544
attaching to a document, 225
charts from, 123
copying styles into, 227, 228–229
creating a database file from, 543–544
creating and managing, 225–229
database tables from, 555
definition of, 181
deleting and renaming styles in, 227
documents from, 182
holding forms, 192–193
presentations from, 374–375
saving charts as, 122–123
starting presentations with, 373–374
storing macros with, 720
styles available with, 217
in Word, 225
for workbooks, 457–458, 458–459

Template option button, 193
Temporary Internet Files folder, 336
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text
aligning, 91, 509–511
applying font styles to, 42
applying text effects to, 43–45
bending, spindling, and mutilating,

161–162
changing the color of, 45–46, 411–412
changing the font size, 42, 411
changing the look of, 38–46
choosing fonts for, 39–40, 410
converting to a table in Word, 89
decorating in Publisher, 641–644
deleting, 38
on diagram shapes, 141–144
double-spacing quickly, 209
dragging and dropping, 36
editing in Publisher, 633, 635
editing in shapes, 161
editing in text frames, 634
editing macro, 724
editing to fit into text frames, 414–415
entering in a diagram shape, 143
entering into presentations, 409–412
entering into tables, 90
entering on pages, 631–632
entering quickly, 67–68
finding and replacing, 49–56
fitting in text frames, 414–417, 632–635
flowing from frame to frame, 632, 634
flowing from text box to text box, 242
including in a cross-references, 280
manipulating, 35–38
marking as foreign language text, 83
marking for TOC inclusion, 274
merging and centering across

worksheet cells, 512
moving and copying, 36
positioning in frames and text boxes,

417–418
preventing from being hyphenated, 216
preventing from being spell checked, 75
selecting, 35–36, 631, 634

selecting diagram shapes with and
without, 134

shortcuts for selecting in Word,
186–187

shrinking automatically, 633
single-spacing quickly, 209
stripping of all formatting, 37
underlining, 45
wrapping, 235–236, 463

Text Align property, 568
text attributes. See text effects
text axis options for charts, 117
Text Box button, 241
text boxes

“AutoFits” text in, 416–417
creating, 413
creating columns, 239
describing, 241
enlarging to make the text fit, 416
fitting text into, 414–417
inserting, 241–242
inserting in photo albums, 388
linking, 242
manipulating, 162–173
in Photo Album, 389
positioning text in, 417–418
in PowerPoint, 412–414
turning into text box shapes, 160
using shapes, 160–161

text box pointer, 413
text box shapes, 160, 412, 413
text criteria, 603, 604
Text data type, 560
Text Direction button, 102, 234, 413
text effects, 39, 43–45
text file in Publisher, 632
Text Format property, 568
text frames

AutoFitting text into, 414–416
breaking the link between, 634
default AutoFit options, 415, 416
enlarging, 415
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text frames (continued)

filling out in Publisher, 634–635
fitting text in, 632–635
making margins smaller, 633
for paragraphs, headings, and stories,

637
position and size of, 407

Text Highlight Color button, 249
Text in Overflow icon, 632, 633
text labels in worksheets, 463
Text pane, 142–143
text placeholder frames, 378, 409, 410
text watermark, 245
text wrapping, 635–636
Text Wrapping button, 236, 636, 638
texture

describing, 402, 403
filling an object, 174–175
for a slide background, 402–403

theme(s)
customizing, 395–396
defining, 238
for documents, 238–239
for pictures in Photo Album, 389
for presentations, 395–396
selecting, 395, 396
for slides, 393–394

theme colors, 46, 174, 412
Theme Colors button, 239, 396
theme effects, 239, 396
theme fonts, 410
Theme Fonts button, 40, 239, 396
thesaurus, 78, 80–81
third-party dictionary, 74–75
Thomas Gale Company Profiles, 78
thumbnail pages, 188
Thumbnails pane, 188
Thumbnails view

of the Open dialog box, 27
in Picture Manager, 680

tick marks in a chart, 119
Tight wrapping, 636
time formats in Excel, 466

time periods
selecting in Calendar, 353
for self-running presentations, 447

time values
entering into worksheets, 464, 466–467
formatting in Excel, 469–471
rules for, 473

timing presentations, 438–439
title

of a chart, 116
of a report, 612

title bar on the Word screen, 179
title slide in Photo Album, 389
To text box, 316, 318
TOC (table of contents)

changing the look of entries, 273
changing the structure of, 272–273
copying another document, 271
creating, 270–272
customizing, 272
generating, 270–273
marking text for inclusion in, 274
removing, 272
updating and removing, 272

Today button, 351
To-Do Bar, 291, 292
To-Do List, 362
tOGGLE cASE, 48
Toggle Filter button, 593, 594, 597
toolbar button, assigning to a macro, 719
toolbars, hiding and displaying, 626
Top/Bottom Cells option, 471
top-heavy title, 412
top-value query, 607
Total Row check box, 98
Totals button in the Show/Hide group,

606
Totals row, separating, 517
tracing cell references in Excel, 502–503
Track Changes command, 252
Track Changes Options dialog box,

253–254
Track Changes, turning on, 253
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Tracking command in Publisher, 633
Tracking group, 328
Transition Scheme gallery, 428
Transition Speed drop-down list, 428
transitions, 427–428
translating, foreign language text, 83–85
translation service, 78
Transparency slider, 397, 399, 401
transparent colors, 175
Transparent objects, 170
Trust Center dialog box, 716, 717
Trusted Templates button, 226
trustworthy sources, 336
two-digit years, 466, 605
two-input table, 532–534
Two-Page Master option, 646
Two-Page Spread, 624, 626
typing notes, 701
typos, correcting, 64–66

U
unapplying a style, 219
underline, 39
Underline button, 45
underline color, 45
underline font style, 43
underlining text, 45
Undo button

about, 13
after a replace operation, 55
Quick Access toolbar, 38, 62
Word screen, 179, 180

Undo command, 61–62
Unfiled Notes button, 702
unfiltering a list, 529
Unfreeze All Columns, 584
unfreezing in Excel, 481
ungrouping objects, 173
unhiding

columns and rows in Excel, 481
worksheets, 486

unhyphenating, 216

Unicode Expression property, 567
unit measurement labels, 118
Unprotect Sheet button, 487
Unsaved Edits folder, 682
unsplitting in Excel, 480
Unsubscribe link, 347
Up One Level button, 26
Update command, 609
Update Index button, 278
Update Labels button, 265
update query, 609
Update Table button, 272
updating links, 732
uploading files, 712
uppercase, 47
user interface. See interface of Office

2007
user-run presentations, 448–450

V
validation rules, 566
Validation Rule text box, 567
Validation Text text box, 567
value axis. See vertical axis
values on a chart, 108
Var function in Access, 607
VAR functions in Excel, 504
VBA. See Visual Basic for Applications
VCD (Video Compact Disc) video format,

434
vector graphic file formats, 670–671
vertical axis

on a chart, 108, 109
labels on a chart, 116
title on a chart, 116

“vertical” text box, 241
vertical text box, 413
vertical (top-to-bottom) alignment in

worksheets, 510
vertically oriented diagrams, 138
video on slides, 434–436
View All Site Content bar, 711
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View buttons
in Access, 558
on the PowerPoint screen, 372
on the Word screen, 180

View Gridlines button, 88
View menu, 624
View Side by Side button, 64
View tab

commands in the Window group, 64
Custom Views button, 480
Freeze Panes button, 479
Gridlines check box, 165, 426
Handout Master button, 446
Notes Page button, 437
Outline button, 184, 268
Page Layout View button, 519
Ruler check box, 164
Slide Master button, 405
Split button, 185, 479
Zoom controls in, 63–64

views, 383–385
Views drop-down list, 27
viruses. See computer viruses
Visual Basic Editor, 722
Visual Basic for Applications (VBA), 715
Visual Basic Scripts (.vbs), 336
visuals, using to make a point, 378
volume, controlling for sound, 433, 436
Voting buttons, 328

W
watermarks, 245–246
.wav extension, 431
.wav sound file, 364
WAV-file-size-link setting, 432
Web Collections

folder, 691
searching, 690

Web layout view, 184, 185
Web Layout view, 250
Web log. See blog

Web pages
entering addresses for, 57
linking hyperlinks to, 56–57
opening in browsers, 666
saving Office files as, 664–666
turning files into, 665–666

Web-based e-mail accounts, 347
Webdings, 48
weight

choosing for shape outlines, 176
of horizontal rules, 642
of a line, 154

What-If Analyses, 530–534
white screen, during a presentation, 445
width

adjusting for worksheet columns, 514
changing for gridlines in chart, 120
scaling worksheets by, 521

Width boxes for objects, 165
Width text boxes, 93, 94
wildcard characters in Access, 588, 589
wildcard operators, 52–53
wildcards, 604
Window group on the View tab, 64
window, splitting a, 185, 186
Windows Clipboard. See Clipboard
Windows Explorer, opening files, 28
Windows key+N, 702
Windows Media Audio file, 431
Windows Media Player, 434
Wingdings, 48
.wma extension, 431
WMV (Windows Media Video) video

format, 434
Word

aligning text in columns and rows, 91
blogging from inside, 666–668
changing case in, 47
changing the size of a table, 93
Chart button, 110
color scheme for, 657
creating tables, 88–89
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describing a blog account to, 667–668
description of, 9
effects available only in, 44–45
Find and Replace dialog box, 49, 50
Find operation in, 50
grammar checker, 76–77
keyboard shortcuts in, 657–659
positioning Charts in, 113
screen of, 179–180
searching for formats, 51–52
searching for special characters, 53–55
selecting text, 36
speed techniques, 179–194
status bar, 656
turning off text wrapping, 104
tweaking Access reports in, 616
using a language besides English, 82
writing PowerPoint text in, 375
writing Publisher text in, 631–632

Word documents. See document(s)
Word Translation ScreenTips, 85
WordArt button, 162
WordArt frame, 637
WordArt gallery, 161
WordArt image, 161, 162
words

capitalizing each, 47–48
editing in a WordArt image, 162
finding, 49–55
finding all forms of, 51
finding whole in, 51
selecting, 35, 187
translating to a foreign language, 83–84

work, ways of distributing, 661–668
work week, reconfiguring in Calendar,

352
Work Week view, 350
workbooks, 459

creating, 457–459
describing, 461
handling worksheets in, 484–486

recycling, 459
storing macros in, 720

worksheets
cell styles, 514–516
centering data on the page, 523
for charts, 108
color-coding, 485
comments for documenting, 481–483
copying, 485
decorating with borders and colors,

514–518
deleting, 485
describing, 459
embedding in Word or PowerPoint,

89, 728
entering data in, 475–476
entering dates in, 461–467
fitting on a page, 519–522
formatting simultaneously, 486
getting ready to print, 519–524
hiding, 486
inserting new, 485
keeping others from tampering,

486–487
laying out, 509–514
linking, 463
making more presentable, 523
moving among, 484
moving around in, 476–477
printing, 519
printing comments in, 483
protecting, 486–487
rearranging, 485
referring to cells in different, 499
refining, 475–487
renaming, 484
scaling to fit, 521–522
selecting, 485
selecting cells in, 483
selecting entire, 481, 483
views of, 477–481
in workbooks, 484–486
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wrap points, 236
wrapping

style , 236
text around an object, 235–236
text in Excel, 463
turning off for overlapping frames, 638

X
x-axis. See horizontal axis
.xls extension, 31
.xlsm extension, 31, 718
.xlsx extensions, 31
XML, 30–31
XY (scatter) chart, 112

Y
y-axis. See vertical axis
Yes/No data type, 560

Z
zero-length string, 567
ZIP codes, 471
Zoom box, 584
Zoom controls

describing, 63–64
on the PowerPoint screen, 372
on the Word screen, 180

zooming in/out in Publisher, 624
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